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Introduction

= This document provides a quick overview of new features in

BioWin 6.0

= Two main areas:
1.  Model Additions
2. Usability Upgrades

I Model Additions

Chemical Phosphorus Removal
Sulfur (Biological, RedOx, etc.)
Industrial Organics

CEPT

Iron RedOx

P Recovery (Brushite, Vivianite)
Cellulose

Source Separated Organics

Usablllty Upgrades

Drawing Tools / Undo

Excel Reporting

Variable Naming / Sorting

Element Tags

Table Transposition

Optional Alarms

More Example Flowsheet Templates
Set All Parameters Default

Metal Salt Sol’n Densities

m3/hr Flow Units Option

Wet Tonne Sludge Cost Option EnviroSim
ASSOCIATES LTD.



Introduction

= For more details on topics, references to relevant sections of
the BioWin Help Manual are provided

= The BioWin Manual is provided in two forms:
1. As a PDF (default install location is C:\Program
Files(x86)\EnviroSim\BioWin 6.0\Manuals)
2. In “Windows Help” format from within BioWin

= To Use PDF = To Use Windows Help
Open it from directory above Select Help > Contents & Index
Or copy it to any other location of - Click Help button & |
your choice (e.g. Desktop, My - Press F1 key on your keyboard (context-
Documents) sensitive method; will open a relevant topic in
the manual)

EnviroSim
ASSOCIATES LTD.



Introduction

= Example Manual reference:

Model Reference > Chemical Precipitation Reactions > Chemical
Phosphorus Removal with Iron Salts

2 BioWin Help Manual

o e & o

o
Hide Back Print  Options

Conterts | index | Search | Favores |

|2] Home Page

Q Welcome to BioWin

@ Help, Tutorials and Examples

@ General Operation

@ Building Configurations

@ Running Simulations

@ Data Output (charts, tables, reports)
([] Model Reference

@ Biological/Chemical Models

B ) Chemical Precipitation Reactions

o :
@ Chemical Phosphorus Removal with Aluminum Salts
[2) Setting up Channels

[?] Chemical Phosphorus Removal Example

Q Modeling Metal-Colloidal Coagulation Reactions

@ Precipitation of Brushite, Hydroxy-Apatte and Struvite
@ Modeling of pH and Alkalinity
@ Modeling of Industrial Components

@ feration and Gas Transfer Model
@ Solid-Liquid Separation / Clarifier Models
@ Modeling Fixed Film Processes
@ Modeling Sidestream Treatment Processss
Q Modeling Granular Sludge Sequencing Tanks
2] Definition of Non-State Variables
@ COD and BOD in BioViin
@ Powerin BioWin
@ Operating Costs in BioWin
Glossary of Terms

@ Iron RedOx Reactions and Precipitation of Vivianite and Fe!

Medel Reference > Chemical Precipitation Reacticns

Chemical Phosphorus Removal with Iron Salts
The following figure illustrates the processes involved in chemical phosphorus removal with iron salts.

- Precipitation
Aging

——= Adsorption

———» Co-precipitation

—— Oxidation

. f16) 1(8)
Fe* —————————— HFO - High Surface HFO - Aged
(P Bound on Aged HMO)
HPOS 1 IR
HFO - High Surface + H" HFO - Low Surface + H"

HFO - High Surface + H,PO," HFO - Low Surface + H,PO,"

Schematic representation of the ferric precipitation model in BioWin

lud h

When the model option ferric - phosp adsorption/ precipi reactions is selected addition of
ferric to water results in the rapid precipitation of hydrous ferric oxides (HFO) with a high number of active surface
sites, HFO - High surface. When the model options Include ferric - phosphate adsorption/precipitation
reactions AND Include iron reduction/oxidation reactions are selected, addition of ferrous to an oxidizing
environment can result in the oxidation of ferrous to HFO — High surface. HFO - High surface will either age to
HFO - Low surface or adsorb/co-precipitate with H,PO,", H*, or colloidal COD {Xsc). The fate of HFO - High
surface depends on the mixing intensity, the pH, and whether the model option Include metal salt - colloidal
material coagulation reactions is selected. (See_Factors Impacting HFQ Interactions).

Depending on the pH, H,PO,” can co-precipitate with HMO - High surface to form HFO - High surface with H_PO,".

EnviroSim
ASSOCIATES LTD.




Model Addition - Sulfur

= Extension of what has been in PetWin for several years
Sulfide-oxidizing bacteria

Sulfate-reducing bacteria (multiple types)
Potential hydrogen sulfide stripping

Iron-sulfide (FeS) precipitation Simpified Sufur Process

Model iron addition for H,S —= Ot .

CO nt rOI >Q> g::gi‘z;gﬁon DO>0_2|:2804 E:gfé?f
AEROBIC lfur H,CO. 002025 ANOXIC

Manual reference:

ANAEROBIC

Model Reference > Biological/Chemical Models > Sulfur
Modeling

T EnviroSim
ASSOCIATES LTD.



Model Addition — Industrial Organics
= Based on original Alison Baker PhD (~1994, McMaster)

Four new state variables for industrial components

Mixed removal pathways — stripping and/or biodegradation
Default settings for industrial components mimic xylene, phenol,
benzene, and toluene

Biodegradation according to inhibitory Haldane kinetics

Monod and Haldane Equations

[ [ —Monod
| Haldane (Kl = 1000 mg/L) S
6 [[| ——Haldane (Kl =100 mgiL)

. ——Haldane (KI = 20 mgiL) _/‘_’__,__.——-—— ﬂ —_— Hmax . S2

2 | h - -
: \
:/ Manual reference:

Model Reference > Modeling of Industrial Components

Growth Rate
(%]

0 10 20 30 40 50
Concentration, mg/L

EnviroSim
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Model Addition — Chemical Phosphorus

= New P removal mechanisms (hydrated metal oxides)
- Based on EnviroSim-sponsored research
- Extensive calibration for wastewater systems
-  Overcomes weaknesses of old “WEF model” (e.g. fixed Me:P

stoichiometry)
- Can have simultaneous ferric / ferrous / alum inputs

———= Precipitation
Aging
——— Adsorption

———» Co-precipitation

AP¥* — = HAO - High Surface HAO - Low Surface HAO - Aged
(P Bound on Aged HMO)

H,PO,” HPO,

(Hd)
(Hd)

HAO - High Surface + H,PO, HAO - Low Surface + H,PO,’

Manual reference:

Model Reference > Chemical Precipitation Reactions > Chemical Phosphorus Removal with Enviros,'m
Aluminum Salts ASSOCIATES LTD.



Model Addition — Chemical Phosphorus

= Updated P removal mechanisms (hydrated metal oxides)

——— Precipitation
Aging

—— Adsorption

——— Co-precipitation

—— Oxidation

Fe?*
0, .,
Xs.c
K Ty X
S T T e wor
H0 % !
. _ 1(G) 1(G)
Fe®" —————————— HFO - High Surface HFO - Low Surface HFO - Aged
' (P Bound on Aged HMO)
H,PO, g |8 H HPO, |2 |2 H
y

HFO - High Surface + H" HFO - Low Surface + H*

\
HFO - High Surface + H,PO, HFO - Low Surface + H;PO,

Manual reference:

Model Reference > Chemical Precipitation Reactions > Chemical Phosphorus Removal with
Iron Salts

EnviroSim
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Model Addition — CEPT

= Option to model colloidal COD / metal interactions
Model can convert non-settleable colloidal COD to settleable particulate
COD in the presence of hydrated metal oxides (HMO)
Process will also reduce potential adsorption of P on HMO
Ideal or model clarifier can then be used to mimic increased solids and

BOD removal

Manual reference:

—— Precipitation
Aging
—— Adsorption

Xsc

f(G) (G

Fe** — = HFO - High Surface HFO - Low Surface HFO - Aged

———= Precipitation
Aging
—— Adsorption

A = HAO- High Surface HAO - Low Surface HAO - Aged

Model Reference > Chemical Precipitation Reactions > Modeling Metal-Colloidal Coagulation EnviroSim

Reactions

ASSOCIATES LTD.



Model Addition — Iron RedOx

= Option to model iron oxidation / reduction reactions
- New ferrous input (as either ferrous chloride or ferrous sulfate)
- Ferrous oxidized to ferric in aerobic environments
- Ferric reduced to ferrous in anaerobic environments
- Option to track iron-based precipitates {i.e. FeS and vivianite

[Fe;(POA4),]}

———»= Precipitation
—— Reduction
—— Oxidation Sbsa, CO,, S Sbsa, Sbsp, H, H,S

FeS

.
L]
"

.
.
.
teus

Fe?t HFO (High Surface, Low Surface, High with P, Low with P, Aged)

............. # HFO - High Surface
Fey(PO,), .

Vivianite P ¢ X
O, H,O

Manual reference:

Model Reference > Chemical Precipitation Reactions > Iron RedOx Reactions and Precipitation  [ERpvIiroSim
of Vivianite and FeS ASSOCIATES LTD.



Model Addition — Options for P Recovery

» Improved tracking of Ca?* and Mg?*
Previously Ca?* and Mg?* only available throughout the flowsheet via
input of soluble influent concentrations
Underestimated the amounts entering digesters via solids streams
limiting the amounts of potential precipitates
Model updated to include Ca?* and Mg?* in biomass (taken up as part of
“synthesis ISS”) and influent degradable solids (X.p)

= Additional sinks for P
Vivianite formation
Struvite formation as in previous versions of BioWin but no longer Mg?*
limited!
Calcium phosphate precipitate (as Brushite)
Lowers return stream soluble POA4 to levels typically observed

Manual reference:

Model Reference > Chemical Precipitation Reactions > Precipitation of Brushite, Hydroxy- EnviroSim
Apatite and Struvite ASSOCIATES LTD.



Model Addition — Cellulose

= Cellulose tracking
- Influent unbiodegradable particulate material split into two
components: cellulose and non-cellulose
- Separate COD:VSS ratios for each
- Helps to fine-tune sludge production and digester performance
- Enables modelling of cellulose recovery

Manual references:

1.  Model Reference > Biological/Chemical Models > Activated Sludge Processes > Growth
and Decay of Ordinary Heterotrophic Biomass > Stoichiometric Parameters

2. Model Reference > Definition of Non-State Variables Enviros"m
ASSOCIATES LTD.



Model Addition — SSO

= New input for SSO

State variable (COD,-X;,) for adding particulate degradable COD (e.g.
Source Separated Organics)

Has specific COD:VSS; added as a separate input to avoid conflicts
with municipal wastewater characteristics

Option to include N and P

Constant or time-varying, as with any BioWin input

Ps Holding Tank Digester
I
Cake
580
P ——

<

Manual references:

1. Model Reference > Biological/Chemical Models > Hydrolysis, Biological adsorption,
Ammonification and Assimilative denitrification

2. Model Reference > Definition of Non-State Variables Enviros"m
ASSOCIATES LTD.




Usability Upgrade — Drawing Toolbar

f) =  UNDO button!! Use for accidental element deletion, moving, etc.
< . = Buttons for copying pipe format from one pipe to others
_' ’ = Buttons for aligning flowsheet elements (vertical or horizontal
E centers)
{_ﬂﬂ = Buttons for spacing flowsheet elements evenly (vertically or
. horizontally)
L = Buttons for flipping flowsheet element images (horizontally or
o ¥ vertically)
-3 = Button for copying selected element(s)
ll
g
- g
i+
- Manual reference:
M+
wh| General Operation > Main Simulator Window > Toolbars > Flowsheet Tools
+ ol

EnviroSim
ASSOCIATES LTD.



Usability Upgrade — Report to Excel

= Automatic rapid generation and export of data, charts, etc. to Excel
= |deal for generating Mass Balance tables to use in PFDs
=  Preconfigured templates are customizable

= Can incorporate “post-BioWin” calculations (e.g. MLVSS/MLSS, COD/BOD)
using Excel formulas

= Option for including both steady state and dynamic simulation databases
= Caninclude BioWin charts — these are converted to Excel charts with data

= Report to Word still available

Manual reference:

Data Output (charts, tables, reports) > Creating Project Reports > Creating an Excel Report

EnviroSim
ASSOCIATES LTD.



Usability Upgrade — Report to Excel

BioWin Mass Balance Summary

NRCY
TES () [mgil] | 850 24
—1—-.-—1— Fiow () [ | 100000.00
5 788 Rem. (%) | 208
SLR [kgim2 g | 13835
Influent Anoxic Aerobic o L [ Effluent
o= = Lo ——oy
LRl N - Mol [mgha) | 1.04
H - N CBO0-T [mgi| 420
F-PO4 M- HOx [mghiL] | 425
H-TH [mghij] 7.4
P - PO4 [mgPiL] | 3.90
P [mgPry| 228
RAS Pump 78S [motl|s3
'WAS Pump WAS

—a——=
Flow [m3id] | 2412.02

CBOD T [y 4] | seen.88

COD-T [k ] | 1948714
M- THN - T g Ng) | 1027.30
P-TP [g Pid] | 330.04

T8 (kg i) | 1eeea2e

VSS [kg ] | 1341509

Mass Rate
=] = = o
% =) o = 5
z 8 2 # g £ 3 g & g
Pipe Name m3/d kg/d kg/d kgld kgld kg/d kg/d kgld kg/d kg/d
F-01 100,000.0 50,000 24,521 22,271 19,771 4,000 2640 0 650 325
F-02 497 588.0 2,066,615 606,634 1,752,419 1,413,482 110,671 3,325 86 35,265 1,491
F-03 497 588.0 2,044,829 592,708 1,742,104 1,402,402 107,991 516 2,314 35,265 1,545
F-04 197,588.0 811,984 235,359 691,775 556,918 42,882 205 919 14,003 613
F-05 97,588.0 3,652 416 891 "7 291 101 454 320 303
F-06 100,000.0 808,332 234,943 690,884 556,201 42,591 104 465 13,683 310
F-07 100,000.0 808,332 234,943 690,884 556,201 42,591 104 465 13,683 310
F-08 97,5880 788,835 229276 674,220 542,785 41,564 101 454 13,353 303
F-09 24120 19,497 5667 16,664 13,416 1,027 2 1 330 7
F-10 24120 19,497 5667 16,664 13,416 1,027 2 1 330 7
F-11 300,000.0 1,232,845 357,349 1,050,329 845,575 65,109 31 1,395 21262 931
F-12 300,000.0 1,232,845 357,349 1,060,329 845,575 65,109 31 1,395 21,262 931

EnviroSim
ASSOCIATES LTD.




Usability Upgrade — Report to Excel

BioWin Tankage Summary
Volume Units: m3
Reactors Name Volume
Aerobic 40,0000
Anoxic 10,000.0
Group Total 50,000.0
Secondary Clarifiers Name Volume
Clarifier 20,0000
Group Total 20,000.0
Total Volume for All Units 70,000.0
BioWin Reactor Summary
All airflows reported at 20 deg C and 1 atm
Bioreactor
. 8 g 3
= = & E 2 =z z E =z a 2z 5
i & 3 2 L E | « w [ H T 2 H
g 4§ g i g s & § & &5 & ¢ § z ¢ ¢ ¢ & 1 B 4
Tank Name m2 m m3 # m3/hr (20C, 1 atm) mglL kaglhr % kglhr % mg/Lihr mglL mglL mglL mglL mg/L mg/L mg/L - kg -
Anoxic 2222 4.50 10,000.0 ) ) 0.0 ] 100.0 [1] 100.0 0.0 3,522 2,841 6.7 00 02 0.2 3.0 6.99 35,218 80.7%
Agrobic 8,889 4.50 40,0000 21,680 49,292 20 4,195 305 1,383 101 338 3,501 2819 1.0 03 43 47 31 6.86 140,044 80.5%
Average 49,292 20 4,195 305 1,393 101 338 3,51 2,830 39 02 22 24 31 B80.6%
Total 11111 50,000.0 21680 49,292 4,195 1,393 175,262

EnviroSim
ASSOCIATES LTD.



Usability Upgrade — Variable Naming & Sorting

= Variables and parameters renamed for improved consistency

= Allows for simpler alphabetical sorting

P - Particulate undegradable [mgP/L]

& BioWin Explorer - Click in left panel to refresh right panel - O X
View
Er Elements State vatisble [ Walue [ Mass rate fkg/d) | Notes [ A
=I- Bioreactor Biomass - Acetoclastic methanogenic [maCOD /L] 011 12,60 "
- Aerobic 1 Biomass - Anamonia oxidizing [maCODAL] 41.75 5010.07
: Biomass - Anaerobic ammoria oridizing [mgCOD /L] 037 44.39
Aerobie 2 Biomass - Endogenous products [mgCOD/L] 543,55 E534158
setobio #3 Biomass - Hydiogenatrophic methanogenic [mgCOD/L] 002 212
Biomass - Methylotiophic [mgCOD/L] 4093 431865
Aerobic 14 Biomass - Niits oxidizing [mgCODAL] 2372 sz U
Anoic #1 Biomsss - Ordinary heterotrophic [maCOD/L) 170,10 140403.04
Anoic H2 Biomass - Phosphonus accumulaling [maCOD /L] 0.3 4131
&1~ Denititation Biomass - Propionic acetogenic [maCOD/L] 0.03 10.76
). Bioreactor - Sidestieam Biomass - Sulfut owidizing [maCODAL] 3264 3917.06
2+ Clafies - Model Bicmass - Sulfur redhucing acetotiophic [gCOD/L] 034 41.35
Bicmass - Sulfur reduucing hychagenatrophic [maCODAL] 8.88 108523
§ E;ﬁi:ﬁ' Anarobic Biomass - Sulfur reduucing propionic acetogenic (maCODA] 0,37 4.5 g
CODp - Adsorber hydrocarbon [mgCOD /L] 000 0.00
- Equalization Tank CODp - Degradable extemal orgarics [mgCOD /L] 000 0.00
£ Irfluent - COD CODp - Slowly degradable colloidal [mgCODAL] 0.41 4860
) Influent - State variable CODp - Slowly degradable particulate [mgCODAL] 86,02 1032172 -
&) Input - FOG CODp - Stored PHA [mgCODAL] 0.00 0ss
5 Input - Methanol CODp - Undegradable celllose [mgCOD /L] 0213 /25268
> Miter - General CODp - Undegradable non-celliose [maCOD/L] 0213 3625265
- Pum CODs - Acetate [mgCOD/L] 0.02 245
" CODs - Complex readily deoradable (maCODAL] 143 17118
#)- Separator - Dewatering unit CODs - Degradable wolatle ind. #1 [maCODAL] i o
+)- Settler - [deal pimary CODs - Degradable wolatle ind. #2 [maCODAL] il o
5 Sludge CODs - Degradable wolatle ind. #3 [maCODAL] 0 I
- Spliter CODs - Methanol [mgCOD/L] 0.00 000
CODs - Propionate [mgCODAL] 0.00 038
CODs - Sokble hydracarbon [mgCODAL] [ i
CODs - Undegradable [mgCODL] 28,00 338010
Gas - Dissolved hydiogen [mgCOD/L] 003 a8
Gas - Dissolved methane [mg/L] 0.00 0ol
Gas - Dissolved nitogen [maN/L] 17.23 2067.80
Gas - Dissolved nitous xide [mghN/LL [ 0
Gas - Dissolved owigen mgrL] 200 23998
Gas - Dissolved tatal CO2 [mmol/L] 550 65276 mmnol/L and kmol/d
Gas - Dissolved total sulfides [maS/L] 054 64.33
HAD - Aged [ma/L] 0 o
HAD - High surface [marL] 0 i
HAD - High with H2PO4- adsorbed [mg/L] 0 i
HAD - Low suface [mgrL] 0 i
HAD - Low with H2PO4- adsorbed [mgéL | 0 i
HFO - Aged mg/L] 0 i
HFO - High surface [mg/L] 0 i
HFD - High with H+ adsaibed [ma/L] 0 0
HFO - High with H2P04- adsarbed [ma/L] 0 0
HFO - Low suface [ma/L] i 0
HFO - Low with H+ adsorbeed [ma/L] i 0
HFO - Low with H2PD4- adsorbed [ma/L] 0 0
Influent inorganic suspended solidk [mal55/L] 365,64 4267396
Metal soluble - Aluminum [ma/! 0 0
Metal soluble - Calcium [mg/L] 16354 20344.05
Metal soluble - Feric [mg/L] 0 i
Metal soluble - Ferrous [mgAL] 0 0
Metal soluble - Magnesium [mgrL] 2472 298634
N - Ammornia mgh/L] 274 32876
N - Nitrate [mgN/L] 20 244.23
N - itte [mgHL] 077 9260
N - Particulate degradable extemal organics [mg/L1 0 0
N - Particulzte dearadable organic [mah/L] 351 42164
N - Particulste indegradable [mal/L] 1057 126884
N - Soluble degradable: orgaric [rmghL] 0.45 5460
N - Soluble undegradable organic [ma/L] 0.80 96.03
Other Arions [strong acids) [meq/L] 1020 122339 meg/L and ken/d
Other Cations (strong basss) [meq/L] 437 596,77 meg/L and ken/d
P - Bound on aged HMO [mgP/L] 0 0
P - Particulate degradable extemal organics [mgP/L] 0 i
P - Particulate degradable orgaric [moP/L] 123 14818

Manual reference:

Model Reference > Definition of Non-State
Variables

EnviroSim
ASSOCIATES LTD.




Usability Upgrade — Flowsheet Tags

= Customizable element-specific information
- Information updates with simulations
- Can contain state, combined, and element-specific variables

NRCY

TSS (U) [mgiL]]8.908.84

-+ =.= <E Flow (U) [m3/d] | 100,000.00
% T5S Rem. [%] | 5957

SLR [ky/(m2 d)] | 138.38

Influent Anoxic Aerobic SOR [mai(m2 d) | 19.52 Effluent
-.

T

N- NH2 [mgNiL] [ 662

N - NOx [mgNiL] | 0.17

P-PO4 [mgPiL] | 3.00
TSS [mgiL]| 252182

N- NH2 [mgNiL] [ 1.04
CBOD-T [mgiL] | 4.26
N - NOx [mgNiL] | 4.85
N-TN [mgNiL]| 7.4

P-PO4 [mgPiL] | 2.10
P-TF [mgFiL]|2.28

TS [mgiL]|5.12

-~

WAS Pump WAS

> ©———in
Flow [m¥d] | 2.412.02

CBOD-T [kg /d] | 5.666.88

COD-T [kg /d] | 19,457.14
N-TKN-T [kg Nid] | 1.027.30
P-TF [kg Fid] | 220.04

TSS [kg /d] | 16,684.28

VSS [kg/d] | 1241568

Manual references:

1.  General Operation > Customizing BioWin > Customizing the Project Appearance > Drawing
Board

2.  General Operation > Customizing BioWin > Customizing the Work Environment > Default tags

3. General Operation > Managing BioWin Projects > Setting Project Options > Drawing Board EnviroSim
Options ASSOCIATES LTD.



Usability Upgrade — Flowsheet Tags

[ [ [ ] [ ] [ ]
= Customizable element-specific information
- Can control location (above, below elements)
- Canreplace flowsheet icons if desired
Influent NRCY
] B Flow [ma/d] | 300000 00
CBOD-T 239.43
COoD-T Eﬁ: 500.00 Flow [m3/d] | 30000000 [T Power [kW]|61.49
N-TKN-T [mgh/L]| 4000 CBOD - T [kg/d] | 34349521 || PEI [KW-hri(ML m)] | 3.21
P-TP [mgPiL]| 6.50 COD-T [kg /d] | 1290745 86
7SS [mgiL| 224.41 N-TKN-T [kg Nig] | 72664 49
vss [mgi]| 190 41 P-TP [kg Pid] | 2664577
Flow [m3/d] | 100000 00[ | TSS [kg /d] | 1095243.30
5 o] [ VsS [kg /d] | 871826 27
COD-T [kg /d] | 50000.12
N-TKN-T [kg N/d] | 4000.30 .
Pl (L | [0 Aerobic Effluent
TsS [kg /d] | 22441.05 Anoxic N-NH3 [mghL]| 1.36
VSS [kg /d] | 19941.05 N-NO2 [mghiL]|0.40 TSS (U) [mg/L]] 7205.23 N-NH3 [mgNiL]| 1.36
N-NH3 [MgNL]| 680 =—1\ yoa mgni|3.01 Flow (U) [m3/d] | 100000.00 Flow [m3/d] | 97567 98— CBOD - T [mg/L]| 4.84
Leloes a7, U8 [ G- DO [manj|2.00 % TSS Rem. [%] | 99.88 CBOD-T [kg /d] | 47222 N-NOx [mgNa ]| 4.30
R e vss [man | 2006.00 SLR [kg/(m2 d)] | 144.27 cOD-T [kg/d] | 3767.88 N-TN [mgni] | 7.61
LD Ld| ety 55 [moi)| 265081 SOR [ma/(m2 a)]| 19.52 N-TKN-T [kg Nig] | 322.12 P-PO4 [mgPiL][2.14
P-PO4 [mgP/L]| 214 P-TP [kgP/d]| 229.25 P-TP [mgPiL]|2.35
TS5 [kg /d] | 833.18 785 [moiLl| 8 54
RAS Pump vSS b k| 663.22
P Fiow [ma/d] [ 100000 00
Flow (m3/d] | 97567 98 < Power (kw] | 1565
CBOD - T [kg /d] | 220317.41 PEI [kW-hr/(ML m)] | 3.21
COD-T [kg /d] | 825037 49
N-TKN-T [kg Nid] | 46390 05
P-TP (kg Pid]| 1703113 WAS Pump WAS
T5S [kg /d| 703144 02 Flow [ma/d] | 2412 02 N-TKN-T [mgniL]| 47537
VSS [kg /d]| 559710.73 Power (kw]]029 [ Flow [m3/d]| 2412.02 [ P-TP [mgPiL]| 174 52
PEI [kW-hriML my] | 3.21 CBOD - T (kg /a] | 5445 45 755 [mgi | 7205 23
COD-T [kg/d]| 20414 18 vss [mgn| 573545
N-TKN-T [kg Nig] | 1146.50
P-TP [kgP/d]| 420.95
ss [kg /a)| 17379.17
VsS [kg /d]| 13834 02

EnviroSim
ASSOCIATES LTD.




Usability Upgrade — Integrated Influent Specifier

B BioWin Simulator - Untitled.bwe

File Edit Tools Project View Simulate Help

DB ES|(NEEB & YO

== Influent Specifier - Untitled.ets

x
File Setting View Stoichiometry About
e— -
L m m @ B A =
Input Measurements Adjust Fractions View Results Export to BioWin
Table View
H i -
Raw (Un'ﬁll:ered) - rl lomogenize l COD - Total [mgCOD/L] 500.0
BOD - Total [mgBOD/L] 245.2
N - TKN [mgh/1] A0.0
P - Total P [mgP/L] 6.3
I 5 - Total 5 [mg5/L] 15.0
Glass-Fiber Filter Alkalinity [mgCaCO%/L] 3000
(1.2 pm) TS5 [mgTss/L] 2427
WSS [imgVSs/L]) 1977
COD - Filtered [mgCOD/L] 184.9 Coagulate / Flocculate
CODs - Acetate [mgCOD/L] 120
BOD - Filtered [mgBOD/L] 1025
N - Ammania [mgh/L] 264
N - Nitrate [mgM/L] 0.0 Membrane Filter {0.45 pm)
P - Soluble phosphate [mgP/L] 33 RN
COD - FF [mgCOD/L] 105.0
Other Measurements:

Flow 00 Gas - DO [mgO2/1] 00 Effluent COD - Filtered [mgCOD/L] 25.0

pH 73 Metal - Calcium [mg/L] &0.0 Metal - Magnesium [mg/L] 15.0 En Viro s'.m
ASSOCIATES LTD.




Usability Upgrade — Integrated Influent Specifier

B BioWin Simulator - Untitled.bwe

File Edit Tools Project View Simulate Help

DB ES|(NEEB & v ¥o|l?2a|8 -]

= Components of Influent

Influent Components (COD, N, P and ISS content) - Select tabs at lower left

COD - Total
Measured Calculated
500.0000 mgCOD/L K1 for CODc - Xsc I
aops [ass20s1 | [ass20s1 |
k2 for CODp - Xsp : |
fBODS (GFOY  [1024611 | [1024611 |
Biomass Degradable Undegradable
Fbio. = |0.0212 I Fdeg = |0.7383 Fundeg = |0.1200
Conc = |10.6000 mgCOD/L Conc = 2394000 mgCoD/L Conc = (90,0000 mgCOD/L
Readily degradable Slowly degradable CODs - Undegradable CODp - Undegradable
Fbs = |0.1600 Fxs = |0.6388 Fus = |0.0500 Fup = 0.1300
Conc = |80.0000 mgCOD/L Conc = 319.4000 mgCOD/L Conc = |25.0000 mgCOD/L Conc = |65.0000 mgCOD/L

CODs - Complex readily degradable CODs - Acetate CODc - Slowly degradable colloidal CODp - Slowly degradable CODp - Undegradable cellulose CODp - Undegradable non-cellulose
Fbsc = |0.8500 Fac = |0.1300 Fxsc = |0.2500 Fxsp = |0.7500 Feel = |0.5000 Fnoncel = | 0.5000
Conc = |62.0000 mgCOD/L Conc = | 12,0000 mgCOD/L Conc = |79.8500 mgCOD/L Conc = |239.5500 mgCOD/L | | Conc = 32,5000 mgCOD/L Conc = 32,5000 mgCOD/L

D N P IS5

Tabs to view COD, N, P speciation = EnviroSim
ASSOCIATES LTD.




Usability Upgrade — Transpose Tables

N/d] | N -Total N [kg N/d] | P - Soluble PO4-P [kg P/d] | P -Total P [ka P/d] |

Elements | COD -Total [kg /d] | BOD - Total Carbonaceous Total suspended solids olatile suspended solids M - Total Kjeldahl Mitrogen
Influent 50,000.12 24,520.56 22,271.22 19,771.22 4,000.30 4,000.30 325.10
Anoxic 2,066,615.31 508,633.78 1,752,419.23 1,413,482.37 110,671.03 110,756.71 1,491.33
Aerobic 2,044,828.86 592,708.01 1,742,104,19 1,402,492.50 107,991.14 110,305.17 1,544,55
Effluent 3,652.17 416,10 890,51 716.91 291.45 745.29 302,92
WAS 19,497.14 5,666,588 16,664.28 13,415.69 1,027.30 1,038.52 7.49
B Edittable X
Table editor
ombined tate varisbles Selected varisbles
Alle A |B-Zaao -~ COD -
CBOD -S B - Zam CBOD-T
CBOD -T B - Zao TS5
COoD -P B-Ze VSS
COD -S B-Zh N-TKN-T
COD-T B - Zhm N-TN L
COD - VFA B - Zm P -PO4
I5Scel 8- Zno > |p-TP +
IS5prec B-Zpa
[S5tat B - Zppa
M-Al-T B -Zso
M-Fe -T B - Zsra
N -NOx v [B-zsh v I Duplicates
Element specific Water chemistry
--- 1. Diffused aeration --- ~ Ac- -~
# of diffusers A3+
Air flow rate CO3=
Air flow rate / diffuser fd
- 2. Reactors and digesters -—- Fez+ Add blark line
Actual DO sat. conc. Fe3+
Alpha A v Add total so far
Elements Selected elements o
El Blements Influent " Concentrations
[#)- Bioreactar Anoxic
(EI\;‘nﬁErt ~Model peabic.  Mass rates
- Effluen
Influent - COD 5 s * | o
Pump +
. j;.dci:r [¥ Transpose table
J Cancsl
Elements | Influent | Anoxic | Aerobic | Effluent | WAS
COD - Total [kg /d] 50,000.12 2,066,615.31 2,044,828.86 3,652.17 19,497.14
BOD - Total Carbonaceous [kg /d] 24,520.56 606,5633.78 592,708.01 416.10 5,660.88
Total suspended solids [kg /d] 22.271.22 1,752,419.23 1,742,104.19 390.51 16,664.28
Volatile suspended solids [kg /d] 19,771.22 1,413,482.37 1,402,492.50 716.91 13,415.69
M - Total Kjeldahl Mitrogen [kg MN/d] 4,000.30 110,671.03 107,991.14 291.45 1,027.30
N -Total M [kg N/d] 4,000.30 110,756.71 110,305.17 745.29 1,038.52
P - Soluble PO4-P [ka P/d] 325.10 1,491.33 1,544.55 302,82 745
P -Total P [ka P/d] 650,20 35,265.05 35,265.05 320,15 330,04

650,20
35,265,05
35,265,05
32016
330,04

EnviroSim
ASSOCIATES LTD.




Usability Upgrade — Optional Alarms

= As part of the project
options, select which
alarms are active

Manual reference:

Er Current Praject Opticns

hadel | Unit system | Numerical parameters  Alarm options DrawingboardIPipe |

Include (check) / exdude (uncheck) the following alarms in this project

low spedfications could not be achieved

pecified D.O setpoint above 90%: saturation value - using 90%: of saturation value
[w| Nitrogen limited conditions occurred

[w] Phosphorus limited conditions occurred

[w] Calcium or Magnesium limited conditions ocoured

ore than 10%: of effluent N is stripped as ammonia

The air flow rate required to achieve the DO setpoint exceeds the specified maximum air flow rate
The desired air flow rate was adjusted to within the range spedified.

[w| The power supply required to achieve the DO setpoint exceeds the maximum power supply rate
|| The power supply requested exceeds the maximum power supply rate

[#] High air flow | diffuser

0 in tank is higher than specified setpoint due to DO in input (even without aeration).
ow pH inhibition for autotrophs

igh pH inhibition for autotrophs

ow pH inhibition for heterotrophs

High pH inhibition for heterotrophs

Low pH in digester - may be acddic

pH (or IS) could not be calculated - (Jlow bound)

pH (or IS) could not be calculated - (high bound)

5 {or pH) could not be calculated - (high bound)

pH could not be calculated

[+] Warning: High ionic strength (activity coeffidents)

= Calculated pH and specified pH are quite different from each other

The air flow rate required to achieve the DO setpoint is below the spedfied minimum air flow rate
onsider turning on ammonia stripping model and gas phase modelling.

Anion or Cation limitation for growth

Specified DO setpoint cannot be achieved - specify a lower value

w| Biofilm, media and liquid volume exceeds tank volume. Increase the assumed biofim thickness to address this problem.

General Operation > Managing BioWin Projects > Setting Project Options > Alarm Options

EnviroSim
ASSOCIATES LTD.



Usability Upgrade — Set All Parameters to Default

Project  View Simulate

Help

Use to upgrade older models to Version 6

Farameterz
Plant
Cosztz/Enengy

Infa ...

MHaotes

Current Project Options ...
Model builder ...

Mew Project Optionz ..

D atabasze

1

Manual reference:

General Operation > Managing BioWin Projects > Specifying Project Model Parameter Values

|

k

k

Aeration/M azs transfer ..
Einetic ...
Stoichiometnc ..
Setthng ...

Biofilm ...
Phyzical/Chemical ...
Other ...

Set defaults ...

EnviroSim
ASSOCIATES LTD.




Usability Upgrade — Set All Parameters to Default

= Specify which parameter sets to update

& Pararmeters >

et parameters to default values |

Available global parameter lists Selected global parameter lists

= | |Aeration/mass transfer - Aeration ~
= |Aeration/mass transfer - Anaerobic digester
== | |Aeration/mass transfer - Blower
Aeration/mass transfer - Diffuser
< | |Aeration/mass transfer - Emission factors
= |Aeration/mass transfer - Henry's law constants
=< | |Aeration/mass transfer - Mass transfer
Aeration/mass transfer - Surface aerators
Biofilm - Biofilm general
Biofilm - Effective diffusivities [m2/s]
Biofilm - EPS Strength coeffidents [ ] W

Set selected parameter list values to default values

EnviroSim
ASSOCIATES LTD.



Usability Upgrade — Solution Densities

= For metal salt input streams

®  Parameter editor >
Fe rates Fe constants | Fe RedOx rates I CEPT rates I Al rates Al constants
Properties constants Metal salt solution densities | Mineral precipitation rates I Mineral precipitation constants
Parameters
rMote
Marme Default Value The solution densities spedfied are the "pure”
Ferric chloride solution density [ka/m3] 3,620.0000 3,620.0000 component densities.
Ferrous chloride solution density [ka/m3] 3,160.0000 3,160.0000 They areusedmben youl ety fiemet
Aluminium sulfate solution density [kafm3] 1,950.0000 1,950.0000 concentration in terms of % wt. fwt.

BioWin assumes ideal solution behaviour for
volume, that is:

WV =ZVi

or that the mixture volume is equal to the
sum of volumes of its components,

Frint all | Set current tab to default values | 0k, I Cancel

Manual reference:

Model Reference > Chemical Precipitation Reactions EnviroSim
ASSOCIATES LTD.



Usability Upgrade — Additional Flow Units

= Cubic meters per hour option for smaller systems

B - Current Project Options *

hodel  Unitsystem |N rameters | Alarm Uptionsl Drawing boardl Fipe |

& m3/d The same basis is used for flow and
volume, i.e., if L/d are selected for

" m3jhr flow units, then L are assumed for
volume,

L
The flow units "gal/d™ and "mgd” use

ML the U.5. gallon (=3.7854L)

‘el When the flow unit basis is changed,

mad previously entered flows and
" galfd volumes are conver ted
BOD basis

{* 5day

" 7day

20 day

Manual reference:

. R NI : : EnviroSim
General Operation > Managing BioWin Projects > Setting Project Options > Unit System ASSOCIATES LTD.




Usability Upgrade — S per wet tonne sludge costs

= Third sludge disposal cost option added

B Editing WAS
Power/Costs | Tags | Monitor items
¥ Indude this sludge output in power fcost calculations
ludge options (for power fcost calculations)
[ Sludge disposal (dry)
[~ Sludge disposal {volumetric)

¥ Sludge disposal (wet tonne) 0. 1000 £f(wet tonne)

[~ Power

Press F1 for help

| Cancel |

Manual reference:

- - BioWi : EnviroSim
Operating Costs in BioWin > Operating Costs > Sludge ASSOCIATES LTD.




Usability Upgrade — More Examples!!

BioWin Cabinet reorganized and greatly expanded with additional examples

& T||1nnz - i

Full Plant Models r
Biological Mutrient R | » IFAS "
1 iclogical Mutrient Rermova —
Ch g' IPR I 3 MBR "
J emica EMmMova E
£ 4 Ookx R MBEBR 3
nergy an _— .
. - s Trickling Filters k
Sidestrearn Treatment r
1 Onidation Ditch R Other Precipitates r
idaticn Ditches
Chernically Enhanced Prirnary Treatment »
G55T L4 .
Miscellaneous 3
SBR 3
Industrial Exarmples k —
*  Clarifier Modeling » Full Plant Models " Eas ,
I Biclogical Nutrient Rermnoval » —_— T
| Chemical P Removwal b Alum to influent channel E
Energy and OpEx N Alurn to aeration basin
i »
s E e Alum to final clarifier channel
Oxidation Ditch »
weation Fitehes Ferric to influent channel
G55T * . . i
SER ) Ferric to aeration basin
Industrial Examples b Ferric to final clarifier channel
Clarifier Modeling J Ferric Multi-point desing

Simple Ferric addition cemparison

Ferric to influent Alum to aeration basin EnViro Sim
PR TR i 1 ASSOCIATES LTD.




Enjoy Using BioWin 6.0

support@envirosim.com

EnviroSim
ASSOCIATES LTD.



